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® Release History
2014-7-23 :V1.0, UM-MASSDUINO-VO1-EN
First released

2015-11-20: V2.5, UM-MASSDUINO-V2.5-EN
1, Add MD-328D Support
2, Update MassDuino HSP

2016-04-11: V3.0, UM-MASSDUINO-V3.0-EN
Update new version Arduino IDE Support

2018-08-23: V4.6, UM-MASSDUINO-V4.6-EN
New chip support MD-3248P

2019-09-27: V5.0, UM-MASSDUINO-V50-EN
New chip support Mega2560-CORE

® Background
Arduino is an open-source electronics prototyping platform based on flexible, easy-to-use hardware and software. It is a
very useful and applied tools. We can find many code and sharing information from internet. Arduino development
board has good scalability/ compatibility, and a wide range for application. So we can extend from the Arduino board of the
modaules alls type what we need. It's intended for artists, designers, hobbyists and anyone interested in creating interactive

objects or environments.

Arduino can be very easy to implement prototypes for the original design verification, but if you want a large-scale
commercial applications, the price of Arduino is still too high, so there very little Arduino-based commercial products on the

market.

So we released MassDuino, a new solution that is easy to use Arduino platform advantages, combined with low
manufacturing costs , making the products which is developed on Arduino platform can be mass-produced immediately,

quickly turn ideas into products.

® What's MassDuino

Massduino is a new product line, which combines the Arduino platform peripheral -rich, convenient and quick development,
low-cost and easy to manufacture large-scale production advantages. Almost all of the Arduino code can be applied to
MassDuino without modification (or very small modification), users do not need to learn any new knowledge, you can

immediately begin using MassDuino to commercial product development.

MassDuino use a special custom MCU MD-8088 and MD-328D, those chips has a very unique and new design, ensuring high

operating efficiency while providing a low cost of applications.

INHAOS upcoming a series of application modules which is based MassDuino. The application modules can be developed in
the Arduino environment, and then direct used to commercial products, creative implementation and production time

reduced to a minimum.
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Stage

|

® MassDuino Development Process
This chapter describe how to development a product with MassDuino, We assume that you have some basic knowledge of

electronic technology, and familiar with the Arduino development environment.

51, Understand what is MassDuino, the MassDuino series products are highly compatible with standard Arduino UNO R3,
So you can use MassDuino like the Arduino UNO R3.

SZ, Download MassDuino HSP (Ardunio 3rd-party Hardware Support Package ) from www.inhaos.com , At present the
latest version of the HSP is V4.5, this version support chips is as follows:

MD-8088: 8KB Flash , 1KB SRAM, 10bit ADC

MD-328D: 32KB Flash , 2KB SRAM, 10/12/16 bit ADC

MD-3248P: 32K Flash, 2KB SRAM, 10/12/16bit ADC, 48Pin --- 2 Apr.2018 Add

MD-328D is highest compatible with the ATmgea328P, we recommended to use MD-328D, in most case the Arduino
UNO sketch can be used for MD-328P without any modification.

53, Get one UNO development board , write sketch , run and debug .
Currently we have below products:
MD-8088: MassDuino UNO R4
MD-328D: MassDuino UNO LC, MassDuino UNO LC Lite
MD-3248P: MassDuino UNO Pro, MassDuino UNO LC Pro, MassDuino UNO Core Pro  --- 2 Apr.2018 Add

S4, After prototype verified, do the mass production design, we provided below services:
1, We can help you do the whole product design and fabrication
2, Or you can do the design , we will help you make the prototype / pilot run / and mass production
3, Or you can buy chip from us , we can pre-programmed the chip or leave blank chip to you , with very good price

Need above service, please contact: support@inhaos.com
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® MD-8088 and MD-328D specification

Hi performance,Low power consumption 8bit RISC
MCU

8K bytes of in-system programmable FLASH

1K bytes SRAM on-chip

504 bytes of data FLASH, support byte read
(simulate E2PROM)

Can be edited in the Arduino environment,
concise and easy to use

Programmable synchronous / asynchronous
USART

Can work in master / slave mode SPI Serial
Interface

Up to 30 programmable | / O
High-performance, low -power and low-cost
12C -compatible two-wire serial communication
interface protocols , supporting master and slave

device mode

Hi performance,Low power consumption 8bit RISC
MCU

32K bytes of in-system programmable FLASH

2K bytes SRAM on-chip

1K bytes of data FLASH, support byte read (simulate
E2PROM)

Can be edited in the Arduino environment, concise
and easy to use

Programmable synchronous / asynchronous USART
Can work in master / slave mode SPI Serial Interface
High-performance, low -power and low-cost

12C -compatible two-wire serial communication
interface protocols , supporting master and slave
device mode

1.8t0 5.5V

TQFP-48
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Hi performance,Low power consumption 8bit RISC
MCU

32K bytes of in-system programmable FLASH

2K bytes SRAM on-chip

1K bytes of data FLASH, support byte read (simulate
E2PROM)

Can be edited in the Arduino environment, concise
and easy to use

Programmable synchronous / asynchronous USART
Can work in master / slave mode SPI Serial Interface
Up to 30 programmable | / O

High-performance, low -power and low-cost

12C -compatible two-wire serial communication
interface protocols , supporting master and slave
device mode

8-CH 10bit 250Ksps ADC

1.8to0 5.5V
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® MassDuino UNO family selection guide
No Items BUONO MassDuino MassDuino MassDuino
: UNO LC UNO R4 UNO LC UNO LC Lite
1 Microcontroller ATmega328P MD-8088 MD328D MD328D
2 Operation Voltage 3.3Vor5Vv 3.3Vor5V 3.3Vor5Vv 3.3Vor5Vv
3 Input Voltage (recommended) 7-24V 7-24V 7-24V 7-24V
- " 14 (of which 6 provide PWM 14 (of which 6 provide PWM 14 (of which 6 provide PWM 14 (of which 6 provide PWM
4 Digital 1/0 Pins
output) output) output) output)
5 Analog Input Pins 8 (A6/A7 in Extend) 8 (A6/A7 in Extend) 8 (A6/A7 in Extend) 8 (A6/A7 in Extend)
6 ADC Resolutions 10 bit 10 bit 10/12/16 bit 10/12/16 bit
32 KB 8 KB 32 KB 32 KB
7 Flash Memory of which 0.5 KB used by of which 1 KB used by of which 1 KB used by of which 1 KB used by
bootloader bootloader bootloader bootloader
8 SRAM 2KB 1KB 2KB 2KB
1KB 1KB
9 EEPROM 1KB 5048 Share with Flash Memory Share with Flash Memory
10 Clock Speed 16MHz 16MHz 16MHz 16MHz
Interface Micro USB . - Micro USB ' -
11 (CH341) 6Pin UART Serial Light (CH341) 6Pin UART Serial Light
12 Picture
6Pin USB2Serial Light USB UART interface 6Pin USB2Serial Light
USB UART interface MD-8088 Chipset MD328D Chipset MD328D Chipset
13 Main Advantage ATmega328P Chipset Very Good cost performance 10/12/16 bit ADC 10/12/16 bit ADC
8 Good cost performance Line Regulator, low noise Very Good cost performance | Very Good cost performance
Line Regulator, low noise WILL BE PHASE OUT SOON, USB UART interface USB UART interface
NOT RECOMMEND! Ready for mass production Ready for mass production

® How to use

We released an Ardunio 3rd-party hardware package for MassDuino , so you can download it from website

(www.inhaos.com) before using it , and put it in the appropriate location, then you can use it like to use any other

Arduino board. The installation process is as follows.

stepl: Download the Arduino software from the official website and then install it on the computer.
( Surport Arduino 1.5.X and Arduino 1.6.x)

& Blink | Arduino 1.5.4 = B =

File Edit Sketch Tools Help

S* |
Blink

Tuwrns on an LED on for one second, then of —

n

This example code iz in the public domain.

*f

// Pin 13 has an LED connected on most Ardui -

step2: Download the MassDuino surport package
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E Arduino - MassDuino_Support_Package

step3: Install MassDuino surport package to Arduino IDE
PS: Before do this, please make sure your Arduino IDE is closed.

Unzip the support package file, and move the two Folders (libraries and hardware) to:

C:\Users\<USERNAME>\Documents\Arduino

You can check Arduino->File->Preferences to find your support file installation directory.

Blink | Arduine 1.5.4

File Edit Sketch Tools Help

f#
Preferences = % J

C:\Us ers'-]locum ents'Arduine

Editor languege: English (English)

w | (reguires restart of Arduine)

Editor font size: 18 (requires restart of Arduins)

Show werbose output during: Dcompilation I:lupload

In my computer, the support package Installed here.

= | = Py
@U v| ) % Local Disk (C:) » Users »-» My Documents » Arduino » r "’| Search Arduino Pl
File Edit View Tools Help
Organize » Include in library - Share with » New folder =~ @
=
457 Favorites Mame Date modified Type Size
I
Bl Desktop .. hardware 2014/7/313:50 File folder
& Downloads .. libraries 2014/7/313:50 File folder
i__-. Recent Places | Install 2014/4/1516:18 Text Document 2KB
4 Libraries
> @ Documents
[» J? Music

step4: Connect MassDuino board to your computer with a USB-Serial adapter and USB cable.
Used standard Arduino USB2Serial Light cable to upload sketch and communication.

® My first MassDuino sketch
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Open the Arduino IDE. Select the board: Click Tools -> Board -> MassDuino UNO R4.0

Blink | Arduing

[ESRIET==)

(e Edi Shetc| Tooh] g |

Atto Format +T
Archive Sketch

// Bin 13 has an LED connected om most Arduine boards.
// give it a mame:

int led = 13:

/ the setnp routine runs once when you press reset:
void setup() {
/ initialize the digital pin as an ontput
pinMode (led, OUTEUT):
1

// the loop romtine runs over and over again forever
void 1aop () {

digitalWriteled, HIGH): // twn the LED on (HIGH is the

Blink Fix Encoding & Reload
! Serial Monitor Ctrl+Shift+M
Blink T
Turns on mlu Board y < )
=114 ¥ rduino Yun
This example ¢ P s
/ Programmer 3 i . o
Arduino Duemilanove or Diecimila
Burn Bootloader .
Arduino Nano

delay (1000):

delay (1000);

digitaliirite (led, LOW):

/ wait for a second

wait for a second
turn the LED off by making

Arduino Mega 2560 or Mega ADK
Arduino Mega (ATmegal280)
Arduino Leonardo

Arduino Micro

Arduino Esplora

Arduino Mini

Arduino Ethernet

Arduino Fio

Arduino BT

LilyPad Arduino USB

LilyPad Arduino

Arduino Pro or Pro Mini
Arduino NG or older
Arduino Robot Control
Arduino Robot Motor

Arduino ARM (32-bits) Boards
Arduino Due (Programming Port)
Arduino Due (Native USB Port)

Mecali A

MassDuino MD-328D

MassDuino MD-8088

2)  Select the COM: Click Tools -> Serial Port -> COM4(which connected with MassDuino.)

P
Blink | Arduino 1.5.4

|
File Edit Sketch| [Tools |l

[ESTEER )

#/

Auto Format

Archive Sketch

Ctrl+T

Fix Encoding & Reload

Serial Monitor

Draed

Ctrl+Shift+M

Port

b COR3

51,

77 give it
int led = 1

Programmer

Burn Bootloader

v | com4

3) step6: An example of program: Click File -> Examples -> which you want.
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I §
€3 Blink | Arduino 1.5.4 9 =RECIE X
7 | — tdit Sketch Tools Help
New Ctrl+MN
Open... Ctrl+0O
Sketchbaol 3 AnalogReadSerial
8 - Examples 3 Digia Savallinimum
Close CIrl+ 03.Analog 3 Blink 10
Save Ctrl+5 04.Communication » DigitalReadSenal
Save As.. Ctrl+5hift+5 05.Control 2 Fade
Upload Ctrl+U 06.Sensors 3 ReadAnalogVoltage
Upload Using Programmer  Ctrl+Shift+U 07.Display =i
08.5tri 3
Page Setup Ctrl+Shift+P e
- 09.UsSB 3
Print Ctrl+P
10.StarterKit »
Preferences Ctrl+Comma ArduincISP
Quit Cirl+Q DallasTemperature »
Enerlib 3
// the loop routine runs over s Ethernet ) WEL
vold loop l[) { SRO4_Example
4) step7: Upload the blink example to MassDuino.
r Blink | Arduino 1.5.4 =)

File Edit Sketch Tools Help

Elink &
// Pin 12 has an LED comnected on most fArduino boards. g
// give it a name:

int led = 13;

// the setup routine runs once when yvou press reset:
void setup() {
// initialize the digital pin as an output.
pirMode {(led, OUTFUT) ;

// the loop routine runs over and over again forever:
void loop() {
digitalWrite(led, HICH): // twrn the LED on (HIGH is the woltage level)

delay (1000) ; // wait for a second
digitalWrite(led, LOW); // twrn the LED off by making the voltage LOW
delay (1000) ; // wait for a second

5) Now you can see the LED is blinking according to the arduino code.
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USB to Serial
Light

(.,.n i .
[ILJ .

%

You can choose the System volta
between 5V and 3.3V by jumper

k —
ggi dsmg_mmjcgq &ggvgm;s
o far] e 5
TXD n nx: D,:f%m TALEH=PURI . % é
5V - NOL
GND ! ¥ S H L@
GND £ oNE D | =
L [
o (B e I
o E=r : I
& il w2
|_| 1 POUER  ANALOG 1IN
o = o
ge =T TN (@
@ = i
68,539 (mm) >

® About the analogRead speed for MassDuino MD-328D
The MassDuino MD-328D support 3 kinds of analogRead mode:

Mode Resolution Function Time takes
1 10 analogRead() 300us
2 12 analogRead_12bits() 768us
3 16 analogRead_16bits() 8ms

So the higher resolution it outputs the longer time it takes, please select the appropriate output resolution according to

your specific application.

® How to use MD-328D to replaced ATMega328P in Arduino system
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U3
ATMEGA328P-TQFP32 / MD-328D-TQFP32

ASSDUI
ARDUINO COMPATIBLE
SYS VICC R9,10,11,12: ATMega328p : OR
MD-328D :NC 4
vee
) R3 OR OR NC PES 6 oo
c4 1 RIO OR OR NC SWC 18
100 T AVCC
T I R11 OR OR NC PE4 : GND
_ ] ; 77 GND
(-ﬁ[; 1000F _L _rz OR OR NC SWD 21 | enp
! [
AREF 100nF 20 AREF
7 ||[15pF M ;
! 1
. == R3
(‘NU'I”—' T 16MHZ
| 8
& | [15pF
For Debug 19 1 Apce
==— ADCT
Il | — SWC
PROG | 2 ‘Whl- GND
3 SWD

PBA{PCINT&/XTALITOSCI)

PBT{PCINTVXTALZTOSC2)

PDORXD/PCINTIG)
ATMEGA328P-AU pirxprommin)
or PD2(INTOPCINTI)
PD3(PCINT19/0C2B/NTI )

MD-328D PD4(PCINT20/SCK/TO)
PDS(PCINT21/0COBTI)
PD6(PCINT22/0COA/AIND)

PD7(PCINT23/AINT)

PCO{ADCO/PCINTE)
PCI{ADC1/PCINT9)
PC2{ADCEPCINTI0)
PCHADCYPCINTILL)
PCHADCHSDAPCINTIL)
PCS{ADCS/SCL/PCINT13)
PCA{RESET/PCINT14)

PBO{PCINTOCLKOVICP1)
PRI(PCINTLIOCI A)
PB2(PCINT2/SS/OCB)
PB{PCINTY/OC2AMOSI)
PB4{PCINT4/MISO)
PRS(SCK/PCINTS)

0 00 R6 1K

UsB_TKD

USE_RXD

i A

4 AL

5 AD2

0 AD3

7 ADHSDA

& ADS/SCL

Cl RESET

12 108

13 109

4 55

5 MOSI

[ MISO

7 SCK
ADCT
ADCH

The schematic showed the hardware difference between MD-328D and ATMega328P, here only 4pins need to

difference connection:

No. Pin Number ATMega328P pin Function MD-328D pin Function Remark
1 3 GND PE4 R11
2 6 vcC PES R9
3 18 AvVCC SWC R10
4 21 GND SWD R12

INHAOS Arduino UNO LC design support both ATMEGA328P and MD-328D , the difference of them is the resistor ,
R9,R10,R11,R12, if user want use MD-328D to design his own project, just reference the schematic show above.

INHAQS also sell MD-328D with very good price, please contact : support@inhaos.com
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® MD-3248P --- new chip released on 2018

We release two new chip MD-3248P, below is the new feature of MD-3248P. to use MD-3248P, please go
to www.inhaos.com download the newest version of Arduino support package , the MD-3248P will be supported start
from V4.0.

Below are some feature function which supported for MD-3248P

1. digitalToggle()

Description
This function is used to toggle the specified pin.

Syntax
digitalToggle( pin )

Parameters
pin: the number

Returns
Nothing

Example Code
void setup() {
pinMode ( , OUTPUT ) ;

Iy

void loop() {
digitalToggle( ); // Toggle the pin status
delay( ); // waits for a second

1
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2. fastioMode()

fastioToggle( )
fastioWrite( )

fastioRead( )
Description

This function is used to fast operation the specified pin.

Syntax
fastioMode( pin , dir)
fastioToggle ( pin)
fastioWrite ( pin, value)
fastioRead ( pin )

Parameters
fastioMode( pin, dir)
pin: the pin number

dir: INPUT or OUTPUT

fastioToggle( pin )
pin: the pin number
fastioWrite( pin , value )
pin: the pin number
dir: HIGH or LOW
fastioRead( pin )
pin: the pin number

Returns
fastioMode( pin , dir)
nothing
fastioToggle( pin )
nothing
fastioWrite( pin , value )
nothing
fastioRead( pin )
HIGH or LOW

Example Code
void setup() {
fastioMode (

void loop() {
fastioToggle(

// like pinMode( pin ) function

// toggle the pin status

// like digitalWrite( pin ) function
// like digitalRead( pin ) function

// like pinMode( pin ) function

// toggle the pin status

// like digitalWrite( pin ) function

// like digitalRead( pin ) function

// like pinMode( pin ) function

// toggle the pin status

// like digitalWrite( pin ) function

// like digitalRead( pin ) function

, OUTPUT ) ;

); // Toggle the pin status

Binwnos®

Everything done inhouse
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3. sysClock ()

Description

This function is used to switch clock source between internal or external.

The MD-328D and MD-3248P have build in 16MHz RC clock source , the MCU will be default to use internal
clock source, in some usage , user need to switch to extnal clock source , use this function to switch clock source
to extnal source.

Notice: the Ext OSC driver using 10 PB6 and PB7 , the PB6 is mapping to Arduino digital 10 D22 , and PB7
is mapping to Arduino digital 10 D27.

Both D22 and D27 only available with INT_OSC, if you using EXT_OSC , do not operation D22 and D27 ,
otherwise it will switch the system click source to INT_OSC.

Ty DR 08
i e 16 BHD9 8L
pes . = 20 FRD10,/CS 85
s D11/ MOSI/HTINZ MOSI
Fba s | 5T D12/MIS0 MISO
B5/AC1P/SPI D13/5CK SCK R3
LRl 11 D22/¥0 ¥OouT 1M 1%
= 12 B277H XN
P S
I PCOSA DD A PP ! [i4/a0 ADO T
e 36 D15/A1 AD] 3 1
o mocamenn 12 16/ AD2 1 1 loMiz
o 38 AD3 e — . — (21
ATADCATS :‘_[ ADA/SDA fl._;;L —|_ i —|_ L 5pF
Y= 5Cl 10 § _.‘IL]}'?H( 1T
: = 41 MCU_RESET  d2B/RST R12 RESET T
T 12 D23/88 10R D23/A8 GND
Syntax
sysClock ( clk_Source )
Parameters
clk_Source: INT_OSC or EXT_OSC
Returns
Nothing
Example Code
void setup() {
sysClock(EXT_0SC) ;
pinMode (13, OUTPUT);
Iy
void loop() {
digitalToggle( ); // Toggle the pin status
delay( ); // waits for a second
}
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4. getBootResetFlag ()

Description
Get system reset source.

Syntax
getBootResetFlag( )

Parameters
Nothing

Returns
0x 07 : Power on Reset
0x 08 : Watchdog Reset
notice: when press Hardware reset pin to reset , the MCU will entry bootloader code area and will

jump to application code area by WDT reset, so in this case it also will get WDT reset.
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5. wdt_enable ()

wdt_disable()
wdt_reset ()

Description
In default setting of Arduino , the WDT (Watchdog) was disable , you can enable watchdog to make your
code much stable, use this function to enable the WDT.

Notice: you must put wdt_reset in appropriate location to ensure the WDT will not be overflow in normal
case. normally we put it in main loop.

Syntax
wdt_enable ( timeout ) // enable WDT, the max count is define by timeout parmeter
wdt_disable () // disable WDT
wdt_reset () // Reset the WDT count , must add in main loop if you enable the WDT.

Parameters
timeout: unit: mS, MD-3248P support bleow timeout:
WTO_64MS , WTO_128MS , WTO_256MS , WTO_512MS , WTO_1S, WTO_2S, WTO_4S, WTO_8S,
WTO_16S, WTO_32S
MD-328D support below timeout:
WTO_1MS, WTO_2MS , WTO_4MS , WTO_8MS , WTO_16MS , WTO_64MS , WTO_128MS , WTO_256MS ,
WTO_512MS

Returns
Nothing

Example Code
#include <WDT.h>

void setup() {
// put your setup code here, to run once:
pinMode(! =, OUTPUT);
wdt_enable(WTO_256MS) ;

void loop() {
// put your main code here, to run repeatedly:
//wdt_reset();
//wdt_disable();
digitalToggle(l2);
delay(10);
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6. analogRead ()

analogRead_11bits ()
analogRead_12bits ()
analogRead_13bits ()
analogRead_14bits ()
analogRead_15bits ()
analogRead_16bits ()

Description
Massduino support 10~16 bit ADC resolutions.

Syntax
#include <analogFuncs.h>

analogRead( pin )

Parameters
pin: the number of the analog input pin.
MD-3248P have 12ch ADC, the digital pin number and Analog pin number is below:
A0=D14,A1=D15,A2=D16,A3=D17, A4 =D18,A5=D19, A6 =D20, A7 =D21
A8=D23,A9=D24,A10=D25,A11 =D26

MD-328D have 8ch ADC, the digital pin number and Analog pin number is below:
AO=D14,A1=D15,A2=D16,A3=D17,A4=D18,A5=D19, A6=D20, A7 =D21

Returns
10/12/16 bit ADC value.

Sample Rate:

Mode Resolution Function Time takes Sample (SPS)
1 10 analogRead() 240us 4.174 Ksps
2 12 analogRead_12bits() 340us 2.941 Ksps
3 16 analogRead_16bits() 3.1ms 322.6 sps

Example Code
#include <analogFuncs.h>
unsigned int ADValue = ;
double Voltage = ;

void setup(Q {
analogReference ( EXTERNAL ) ; // External reference source = 4.096V
Serial .begin( B
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7. analogReference ()

Description
Configures the reference voltage used for analog input and analog output.

Syntax
analogReference( type )

Parameters
type: which type of reference to use.
MD-3248P support reference type below:
EXTERNAL: the voltage applied to the AREF pin is used as the reference
DEFAULT: the default analog reference is the voltage of AVCC , for Massduino UNO board , the AVCC is
follow the VCC_SYS , which can be switch between 3.3V and 5V by a jumper.
INTERNAL2V048: a built-in 2.048V reference.
INTERNAL4V096: a built-in 4.096V reference.

MD-328D support reference type below:

EXTERNAL: the voltage applied to the AREF pin is used as the reference

DEFAULT: the default analog reference is the voltage of AVCC , for Massduino UNO board , the AVCC is
follow the VCC_SYS , which can be switch between 3.3V and 5V by a jumper.

INTERNAL2VS56: a built-in 2.56V reference.

Returns
nothing.

Example Code
double Voltage = ;

void setup() {
analogReference ( DEFAULT ) ;
Serial .begin( );

void loop() {
// 12bit read
Voltage = (double)analogRead_12bits (A0) ;
Serial .println ( Voltage );

delay(100);
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8. pwmMode ()

pwmResolution ()
pwmFrequency ()
pwmWrite ()
pwmTurnOff ()

Description
The PWM signal is very useful function , PWM pin will generate a steady square wave of the specified duty
cycle, Arduino used analogWrite() to write an analog value to a pin, but the resolution and frequency can
not be setting . now we provide ways to configure the PWM frequency and resolution.

MD-3248P have 4 timers (MD-328D and ATMega328P have only 3 timers).
Timer0: 8bit, used for general timekeeping (delay() , millis() ... etc)
Timerl: 16bit

Timer2: 8bit, used for some system function ( Tone () ... etc)

Timer3: 16bit

The corresponding PWM pin is as follows:

Timer0: OCOA: D6,D31, OCOB: D5,D35

Timerl: OC1A:D9,D37, OC1B: D10,D36

Timer2: OC2A:D11,D38, 0OC2B:D3,D39

Timer3: OC3A: D33, OC3B: D34, 0C3B: D35 (Multiplexed with OCOB)

Those function only support to Timerl and Timer3, There are pins related to D9,D037,010,D36,D33,D35,D35.
Each timer mapped two digital pins , in the same time , you can only use one of them , for example:

OCOA mapped to D6 and D31 share OCOA ,so you can not use D6 and D31 as PWM at the same time.

We also provide MsTimerl and MsTimer3 function to used the Timerl and Timer3 programming.

Syntax
#include <pwmFuncs.h>
pwmMode (pin , wmode ,fmode , dband)
pwmResolution (pin, resBits )
pwmFrequency (pin , fhz)
pwmWrite (pin , value )
pwmTurnOff (pin)

Parameters
pwmMode ( pin , wmode ,fmode , dband )

pin : the pin to write to.

wmode : PWM_MODE_NORMAL

fmode: PWM _FREQ_BOOST : enable frequency boost x4 mode
PWM_FREQ_FAST: freq prescale = 1 (fast mode)
PWM_FREQ_NORMAL: freq prescale = 64 (default)
PWM_FREQ_SLOW : freq prescale = 1024 (slow mode)
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dband: O

pwmResolution ( pin, resBits )
pin : the pin to write to.
resBits: pwm resolution, value in 1 to 16.

Notice , the difference resolution setting support difference frequency , this function will be return a

frequency show what frequency will be used with this resolution.

pwmFrequency ( pin, fhz )
pin : the pin to write to.
fhz :
Notice , the difference resolution setting support difference frequency , this function will be return a

pwm frequency

frequency show what resolution will be used with this frequency.

pwmWrite ( pin , value )
pin : the pin to write to.
value : the duty cycle tetween 0 to the resolutions.
pwmTurnOff ( pin )
pin : turn off the PWM function , and then operation as GPIO..

To avoid frequency and resolution setting is not match , so please do not configure the frequency and

resolution at the same time.

Returns
pwmMode ( pin , wmode ,fmode , dband )
nothing

pwmResolution ( pin, resBits )
The frequency which match with the specified resolution.

pwmFrequency ( pin, fhz )
The resolution which match with the specified frequency.

pwmWrite ( pin , value )
nothing

pwmTurnOff ( pin )
nothing

Remark
/* the pwm freq and max duty table: with setting:
pwmMode(PWM_PIN, PWM_MODE_NORMAL, PWM_FREQ_FAST, 0);

freq:100, maxDuty:65535
freq:500, maxDuty:32000

freq:200, maxDuty:65535
freq:600, maxDuty:26666

freq:300, maxDuty:53333
freq:700, maxDuty:22857

freq:400, maxDuty:40000
freq:800, maxDuty:20000
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freq:900, maxDuty:17777
freq:1300, maxDuty:12307
freq:1700, maxDuty:9411
freq:2100, maxDuty:7619
freq:2500, maxDuty:6400
freq:2900, maxDuty:5517

freq:1000, maxDuty:16000
freq:1400, maxDuty:11428

freq:1100, maxDuty:14545

freq:1500, maxDuty:10666
freq:1800, maxDuty:8888 freq:1900, maxDuty:8421 freq:2000, maxDuty:8000
freq:2200, maxDuty:7272 freq:2300, maxDuty:6956 freq:2400, maxDuty:6666

freq:2600, maxDuty:6153  freq:2700, maxDuty:5925  freq:2800, maxDuty:5714
freq:3000, maxDuty:5333 freq:3100, maxDuty:5161 freq:3200, maxDuty:5000

freq:1200, maxDuty:13333
freq:1600, maxDuty:10000

freq:3300, maxDuty:4848
freq:3700, maxDuty:4324
freq:4100, maxDuty:3902
freq:4500, maxDuty:3555
freq:4900, maxDuty:3265
freq:5300, maxDuty:3018
freq:5700, maxDuty:2807
freq:6100, maxDuty:2622
freq:6500, maxDuty:2461
freq:6900, maxDuty:2318
freq:7300, maxDuty:2191
freq:7700, maxDuty:2077
freq:8100, maxDuty:1975
freq:8500, maxDuty:1882
freq:8900, maxDuty:1797
freq:9300, maxDuty:1720
freq:9700, maxDuty:1649
*/

Example Code

freq:3400, maxDuty:4705
freq:3800, maxDuty:4210
freq:4200, maxDuty:3809
freq:4600, maxDuty:3478
freq:5000, maxDuty:3200
freq:5400, maxDuty:2962
freq:5800, maxDuty:2758
freq:6200, maxDuty:2580
freq:6600, maxDuty:2424
freq:7000, maxDuty:2285
freq:7400, maxDuty:2162
freq:7800, maxDuty:2051
freq:8200, maxDuty:1951
freq:8600, maxDuty:1860
freq:9000, maxDuty:1777
freq:9400, maxDuty:1702
freq:9800, maxDuty:1632

#include <pwmFuncs.h>
#define PWM_PIN 9

void setup() {
pwmMode (PWM_PIN, PWM_MODE_NORMAL, PWM_FREQ_FAST, 0);

pwmResolution(PWM_PIN, 16);

void loop() {

for ( unsigned long 1 = 0 ;
pwmWrite ( PWM_PIN, 1 )

freq:3500, maxDuty:4571
freq:3900, maxDuty:4102
freq:4300, maxDuty:3720
freq:4700, maxDuty:3404
freq:5100, maxDuty:3137
freq:5500, maxDuty:2909
freq:5900, maxDuty:2711
freq:6300, maxDuty:2539
freq:6700, maxDuty:2388
freq:7100, maxDuty:2253
freq:7500, maxDuty:2133
freq:7900, maxDuty:2025
freq:8300, maxDuty:1927
freq:8700, maxDuty:1839
freq:9100, maxDuty:1758
freq:9500, maxDuty:1684
freq:9900, maxDuty:1616

i <= 60000u ;

freq:3600, maxDuty:4444
freq:4000, maxDuty:4000
freq:4400, maxDuty:3636
freq:4800, maxDuty:3333
freq:5200, maxDuty:3076
freq:5600, maxDuty:2857
freq:6000, maxDuty:2666
freq:6400, maxDuty:2500
freq:6800, maxDuty:2352
freq:7200, maxDuty:2222
freq:7600, maxDuty:2105
freq:8000, maxDuty:2000
freq:8400, maxDuty:1904
freq:8800, maxDuty:1818
freq:9200, maxDuty:1739
freq:9600, maxDuty:1666
freq:10000, maxDuty:1600

i += 1000 ) {

delay (5);
}
pwmTurnOFf ( PWM_PIN ); // trun off the PWM function
delay(100);
digitalWrite ( PWM_PIN , HIGH ) ;// Control as a digital 10
delay(50);

digitalWrite ( PWM_PIN , LOW ) ;

delay(50);

}

// Control as a digital 10
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9. MsTimerl.setMicros ()

MsTimerl.set ()
MsTimerl.start( )
MsTimerl.stop( )

MsTimer3. setMicros ()
MsTimer3.set ()
MsTimer3.start( )
MsTimer3.stop( )

Description
MD-3248P have 4 timers (MD-328D and ATMega328P have only 3 timers).

Timer0: 8bit, used for some system function (delay() , millis() ... etc)
Timerl: 16bit

Timer2: 8bit , used for some system function ( Tone () ... etc)
Timer3: 16bit

Those function will help user to use Timerl and Timer3.

Syntax
MsTimer1 setMicros (unsigned long uS, void (*f)() )
MsTimerl. set (unsigned long mS, void (*f)() )

MsTimer3. setMicros (unsigned long uS, void (*f)() )
MsTimer3. set (unsigned long mS, void (*f)() )

MsTimerl.start () // start the timerl
MsTimer3.start () // start the timer3

MsTimerl.stop () // stop the timerl
MsTimer3.stop () // stop the timer3

Parameters
type:
unsigned long uS: the time on uS for the overflow
f(): "f" is the function which will be called when each overflow. "f" has to be declared void with no
parmeters.
Notice: with MsTimer.SetMicros() function , the overflow range must limit to 10uS to 4095usS.

Returns
nothing.
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10. DAC usage

Description
MD-3248P have 1CH 8bit DAC, to use this DAC, user can be do below step:
S1: set analog reference : analogReference ( DEFAULT );
S2: Set DAC output pin mode: pinMode (4, ANALOG ) ;
S3: write DAC value by function : analogWrite (4, 100 ) ;

Syntax
Parameters

Returns
nothing.

Notice: Limited by the cost, the DAC's resolution and linearity is not so good , for high performance

request application , user can be use PWM + LPF to get very good DAC function.
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11. PMU (Power Management Unit)

Description
MD-3248P provided rich power management function, this is very good in low power application (eg.

battery powered application.)
To use PMU function , you need to add headed file <PMU.h>

Syntax
PMU.sleep(mode, period);

Parameters
mode:
PM_IDLE: IDLE mode, turn off the core clock, reduced power consumption is very small.
PM_POWERDOWN: turn off all clock , wakeup source : pin change int , external int , WDT overflow ,
TMR2 overflow
PM_POFFSO: PowerOff mode 0, wake up source : wakeup source : pin change int, external int , WDT
overflow , TMR2 overflow
PM_POFFS1: PowerOff mode 1, wake up source : wakeup source : pin change int, external int, TMR2

overflow

period:
SLEEP_64MS SLEEP_64MS =0 SLEEP_128MS
SLEEP_256MS SLEEP_512MS SLEEP_1S
SLEEP_2S SLEEP_A4S SLEEP_8S
SLEEP_16S SLEEP_32S SLEEP_FOREVER

Returns
nothing.

Example Code
#include <PMU.h>

volatile uint8_t g_lLastState;
volatile uint8_t g_IntFlag;

void setup()
{
Serial .begin( );
pinMode(~, INPUT);
digitalWrite(”, HIGH);
attachinterrupt(®’, donothing, FALLING);
g_LastState = digitalRead(”);
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12. Virtual USB HID sample

UNO Pro have onboard VUSB interface , user can be programming UNO Pro as an USB HID device such as keyboard /

mice / etc...

Y ?

|

—
®07R
UART port, use this port ® RxD
for uploading sketch ® XD
UART communication . ® +50
5 @ cND

VUSB port , use this po =
for USB communicatih

When use VUSB
connection , the powe

must setto 3.3V

We provide below sample code for fast VUSB coding.

VUsbAIllInOne:
Implement USB keyboard / Mouse /
HID communication

VUsbDatInOut:
Implement USB HID communication

VUsbKeyboard:
Implement an USB keyboard

VUsbMouse:
Implement a USB mouse

- M E A ==

VUshDataSendBack | Arduino 1.
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CH3: D24/A9 B
cHa: D26/a11] -3
v

[E=SFE=

Edit Sketch Tools Help

New

Crl+N

Open... Ctrl+0
Open Recent
Sketchbook
Examples
Close Crrl+W
Save Cerl+5
Save As... Cerl+Shift+§
Page Setup  Ctrl+Shift+P
Print Ctrl+P
Preferences  Ctrl+Comma
Quit Cirl+Q

85 Flipled():

acklen = len:

memepy (sendBuffer, data, 1

Serial write (dats, len)

89 |}

void Loop()
{

wit_reset 0

b

9 veid Flipled ()
0

b

// VUSE event locp
ViisbData. Locp 0

i (acklen > 0)

{
FlipLed();
//delay ms2);
delapMicroseconds (100) ;
VUsbDats. sendData ((nintd |
ackden = 0;

]

}

ool g Flip:

digitalivite(13, gFlip);
£ Flip = lg Flip;

Adafruit Circuit Playground

Bridge
Esplora
Ethernet
Firmata

GSM
LiquidCrystal
PWM

Robot Control
Robot Motor
sD

Servo
SpacebrewYun
Stepper
Temboo
RETIRED

Examples from Custom Libraries
E2PROM
MsTimerl
MsTimer2
MsTimer3
MsTimer4
MsTimer5

PMU
pwmFuncs
Rtc_Pcf8563
SoftwareSerial
SPI
VUsbAllInOne
VUsbDatalnOut
VUsbDevice
VUsbKeyboard
VUsbMouse

»
»
b
b
>
D
D
5
»
»
b
b
>
>
b
5
b
5
»
»
b
b
>
D
D
5
5
»
b
>
{ Vkeyboard
5
D
D

m

DOC ID: UM-MASSDUINO-V51-EN

Release Date: 2021-3-25

www.inhaos.com

Page: 27 of 31


http://www.inhaos.com/�

MassDuino User's manual

ARDUINO COMPATIBLE

Binwnos®

Everything done inhouse

Note, to use VUSB communication , you need to set the power jumper to 3.3V.

VUsbAIllInOne:

This code implement USB keyboard / Mouse / HID communication, to use this code with below step:
1, Connected UART port to PC, and upload the sketch.
2, Change USB cable connected to VUSB port.

3, Open Notepad or text editor, move cursor to edit area.

4, press and hold “D30” button , you will see the text input on the app.

(2 7t - 5=

[ERES )

R $FEE) BN0) FE(N) FEEH)

hella
hella
hellao
hello
hella
hella
hella

world
world
world
world
world
world
world

L

5, press and hold “D32” button , you will see the cursor draw circle on the screen.
6, Open “MassduinoHidDataDemo.exe” which attached in the Arduino - Massduino_Support_Package_V46rl .
7, press “D29” button , you will see the data which the UNO Pro sent to PC via USB port .

Be notice that HID communication support half-duplex only which means you need to make a protocol to
avoid host and device sent data at the same time.

-
o5 Massduine Hid Data Demo

Device Listt DD233B54

L

8, Connected both UART and VUSB port , open “Serial Monitor” in Arduino IDE , then you send data and it will

sent back to PC via UARY port.

-
£ coM12

[¥] Autoseroll

o line ending v 115200 baud v | Clear output

0123456789012345678901234567890123456780012345678901234567890  ~

1234567890123456789012345678901234567890123456789012245678901
2345678901234567890123456789012345678901234567890123456789012
3456789012345678901234567800123456789012345678901234567890123
456789

8 Massduine Hid Data Dema = @] =
Send
: Device List DD233B54 -
init over -
test test test test test test test test test test test test
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Mega2560 Pin Mapping
Mega2560-CORE module

(http://www.inhaos.com/product_info.php?products

id=118) has sink all pin to the DIP 2.54mm pin header
(except Pin-4 ‘PE4’ ), in original Arduino Mega2560
library, not all pin assigned digital pin number,
Meg2560-CORE has patched it.

Pin Description Table (Support on Arduino - Massduino_Support_Package_V50)

Pin Function Arduino Pin Function Arduino Pin Function Arduino
/MCU Mega2560 /MCU Mega2560 /MCU Mega2560
1 VCC 40 GND 79 PB3 D50
2 VCC 41 AGND 80 VCC
3 PG5 D4 42 AGND 81 VCC
4 PEO RXD 43 ADCO A0/D54 82 VCC
5 PE1 TXD 44 VREF 83 PC7 D30
6 PE3 PWM/D5 45 ADC2 A2/D56 84 PC6 D31
7 PE4 PWM/D2 46 ADC1 A1/D55 85 PC5 D32
8 PE5S PWM/D3 47 ADC4 A4/D58 86 PC4 D33
9 PE6 D74 48 ADC3 A3/D57 87 PC3 D34
10 PE7 D75 49 ADC6 A6/D60 88 PC2 D35
11 TXD3 D14 50 ADC5 A5/D59 89 PC1 D36
12 RXD3 D15 51 ADC8 A8/D62 90 PCO D37
13 TXD2 D16 52 ADC7 A7/D61 91 PG1 D40
14 RXD2 D17 53 ADC10 A10/D64 92 PGO D41
15 TXD1 D18 54 ADC9 A9/D63 93 PD7 D38
16 RXD1 D19 55 ADC12 A12/D66 94 PD6 D72
17 SDA D20 56 ADC11 A11/D65 95 PD5 D71
18 SCL D21 57 ADC14 A14/D68 96 PD4 D70
19 PH2 D78 58 ADC13 A13/D67 97 PG4 D77
20 PH3 PWM/D6 59 PJ2 D80 98 reserv
21 PH4 PWM/D7 60 ADC15 A15/D69 99 GND
22 PH5 PWM/D8 61 PJ4 D82 100 GND
23 PH6 PWM/D9 62 PJ3 D81
24 PBO 53 63 PJ6 D84
25 PB4 PWM/D10 64 PJ5 D83
26 PB5 PWM/D11 65 PA7 D29
27 PB6 PWM/D12 66 PG2 D39
28 PB7 PWM/D13 67 PAS D27
29 PLO D49 68 PA6 D28
30 PL1 D48 69 PA3 D25
31 PL2 D47 70 PA4 D26
32 PL3 PWM/D46 71 PA1 D23
33 PL4 PWM/D45 72 PA2 D24
34 PL5 PWM/D44 73 PJ7 D85
35 PL6 43 74 PAO D22
36 PL7 42 75 RESET
37 PH7 D79 76 GND
38 PG3 D76 77 PB1 D52
39 GND 78 PB2 D51

DOC ID: UM-MASSDUINO-V51-EN

Release Date: 2021-3-25

www.inhaos.com Page: 29 of 31


http://www.inhaos.com/�
http://www.inhaos.com/product_info.php?products_id=118�
http://www.inhaos.com/product_info.php?products_id=118�

MassDuino User's manual Yinwaos®

ARDUINO COMPATIBLE Everything done inhouse

DOC ID: UM-MASSDUINO-V51-EN Release Date: 2021-3-25 www.inhaos.com Page: 30 of 31


http://www.inhaos.com/�

MassDuino User's manual Yinwaos®

ARDUINO COMPATIBLE Everything done inhouse

INHAOS Headquarter :
1111 Oakmont Drive #C, San Jose, CA 95117
E-mail : support@inhaos.com

INHAGOS China office :
No.6 Building,Songke Estate,Songshan Lake National Hi-tech Industrial
Development Zone,Dongguan,Guangdong Province, 523808,China

E-mail: Supbpbort@inhaos.com
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